Table of Contents

Introduction .......................................................................................................................... 1
Overview ............................................................................................................................... 1
Getting Started .................................................................................................................... 2
What's New ........................................................................................................................ 3
Navigating the CPR File Viewer ......................................................................................... 5
Open Files .......................................................................................................................... 5
EVM Validity Checks .......................................................................................................... 5
Browse File ......................................................................................................................... 7
Views .................................................................................................................................. 10
  Gold Card ......................................................................................................................... 10
  WBS Element .................................................................................................................. 12
  Sub Total .......................................................................................................................... 13
  WBS Contribution ........................................................................................................... 15
EAC & Efficiency ................................................................................................................. 18
TCPI View Modifications ................................................................................................. 21
Budgeted Work ................................................................................................................... 22
Staffing Deviation ............................................................................................................. 23
Dashboard: Staffing .......................................................................................................... 24
Staffing Changes ................................................................................................................. 25
Baseline Changes .............................................................................................................. 26
Management Reserve Accounting ..................................................................................... 27
Burn Rate .......................................................................................................................... 28
EAC Growth Rate .............................................................................................................. 28
Export to Excel .................................................................................................................. 29
Options ............................................................................................................................... 30
References ......................................................................................................................... 31
  Installation Instructions .................................................................................................... 31
  EVM Gold Card ............................................................................................................... 32
  EVM Rules of Thumb ...................................................................................................... 36
Index ................................................................................................................................. 39
Introduction

Overview

The Contract Performance Report (CPR) File Viewer allows for the viewing and analyzing of several different types of CPRs. The application supports .trn, edi, .xml, and .wsa files to be read, validated, charted, analyzed, and exported to Excel. A background of these different file types (and how they originally may be generated) is briefly provided below:

**edi** - Electronic Data Interchange; Contains components of a single CPR; EDI files produced for EVM CPR’s are typically labeled with the file extension .trn; An EDI is a cost reporting format defined as an X12, transaction set 839, schema for cost reports (where X12 is hundreds of formats, and transaction set 839 is specific for project cost reporting within EDI/X12 that supports DOD [and other Government agency] reporting requirements).
CPR File Viewer User Guide

.trn - Has a defined specification, and any program (such as wInsight) could be adapted to produce trn files.

.wsa - May contain one or more CPR's; History files produces by wInsight.

.xml - Based on Document Type Definition (DTD) for wInsight 6.x databases; Has a defined specification, and any program could be adapted to produce xml files.

The CPR File Viewer supports reading the above files types when available individually, or when packaged in a ZIP file.

A few key features of the File Viewer are listed below:

- **Merge CPR files** of different reporting periods
- **View and export** validation errors and metrics warnings associated with the data
- **View the content of the files via the Browse File tab**
- **View, copy, and export charts of the data**
- **Export** data to Excel

Proceed to **Getting Started** to begin.

**Getting Started**

The following paragraphs briefly summarize the purpose of each tab of the CPR File Viewer. Click on a link to jump to a particular section for more information.

**Open Files** - Once the application is running, you can select a file or collection of files to view. You may either use the "Select File" button to open and merge files one at a time, or use your system's own "Window's Explorer" function to simply drag one or more files at a time and drop them onto the application.

**EVM Validity Checks** - This tab displays a list of warnings associated with the EVM data in the file.

**Browse File** - This tab displays the file content in various data grids. You can select the file and reporting period that you are interested in.

Charting - Various metrics are charted against each other, leading to easier insight into data trends and behaviors.

**Export to Excel** - This feature exports all of the data from a file into Excel format for further analysis and manipulation by the user.
What's New

Updates for Version 1.0.2.22 (Aug 2012)

- New Management Reserve Chart available from the Views tab
- New Monthly Burn Rate Chart available from the Views tab
- New EAC Growth Rate Chart available from the Views tab
- Moved the Benford Chart to the EVM Validity Check tab
- Added a new "Export by EVM Metric" option to the Export to Excel tab

Updates for Version 1.0.2.21 (June 2012)

- New EVM Gold Card Summary Chart available from the Views tab
- The user now has the ability to reorder the series in the charts. This function can be accessed via the context menu on the chart or the ‘Set Y axis scale’ split button.
- The user now has the ability to change the date format via the Options menu.

Updates for Version 1.0.2.20 (March 2012)

- Compressing files is now referred to as Merging files.

- Six charts have been added:
  * TCPI View Modifications - Plots the TCPI, CPI, and Implied Budget Growth for the SubTotal and for a selected WBS element
  * Budgeted Work - Compares the planned (BCWS) versus performance (BCWP) metrics
  * Staffing Deviation - Compares the six month projection to actual values for staffing
  * Dashboard: Staffing - Compares the six month projection to actual and baseline values for staffing
  * Staffing Changes - Compares the last six reports' current values and projections against each other for staffing data.
  * Baseline Changes - Compares the last six reports' current costs and projections (+1, +2, ... +6) against each other for cost data

- The user can set a default size for the CPR File Viewer through the Options menu. This size will be remembered each time the File Viewer is opened.

- Data can be exported to a single sheet in Excel.

- The user can easily select all or some files to merge or remove.

- When double-clicking on a validity check, the "Validity Check WBS Detail" dialog pops up to display the relevant data.
- Performance checks, sanity checks, and/or all checks can be displayed on the EVM Validity Checks tab.

- When hovering over a validity check, a tooltip appears with the reference information (e.g. SCEA CEBoK or GAO Cost Assessment).
Navigating the CPR File Viewer

Open Files

Files are read by the application automatically when selected or dropped onto the application. You may select files with extension .trn, .edi, .xml, or wsa. Alternatively, you may select a zip file which includes the aforementioned file types. Click the Open File button to begin.

If you have opened more than one file and you wish to associate all of the periods contained in those files with each other for analysis purposes, click the Merge Files button. You can merge all the open files or just a select few (using the ctrl key). You can also set a Level Cutoff so that the merge process only goes down to the specified level. Setting a level cutoff may be useful because the majority of merge failures are caused in the "leaf" nodes of the WBS, meaning that if the lower nodes are ignored, the chances of the merge succeeding are greater.

Tip: This "merging" creates one comprehensive whole file, and as such, you should only merge files from the same contract task.

Tip: Files of different types (for example, a .trn and a .xml file) can be merged. If you attempt to merge more than one file containing the same reporting period, CPR File Viewer will only merge one of the files. However, in practice, a program usually submits one or the other type of file consistently. The use case for this is rare but can be supported by the CPR File Viewer.

Closing files can be accomplished with the Remove Files button. To select multiple files to remove, click in the white space to the right of the file name while holding down the ctrl key. Then click the Remove button with the "Selected" radio button option.

Files which contain no validity check errors are marked with a green G (GREEN). Files which do have errors are marked with a red R (RED). Double click on the file name to see the errors on the EVM Validity Checks tab.

EVM Validity Checks

The EVM Validity Checks tab lists errors found in a file.
Select a file from the **Choose a file** dropdown at the bottom of the page to view errors associated with the file. If you merged files on the **Open Files** page, then you must **Choose a Period** to view errors for a CPR within the merged file.

The errors are summarized at the top under the **EVM Validity Check Summary** section. The "Count" column shows how many errors of that nature occur in the report. The "Percent" column shows the percent of WBS elements that triggered the warning relative to the total number of WBS elements. Click on a validity check in the top table to see all errors of this type in the bottom table, titled, **EVM Validity Check Detail**. Double click on an error to pop up the "Validity Check WBS Detail" dialog for that element. This dialog shows a summary of a few metrics pertaining to the element, such as BCWP, ACWP, BAC, EAC, etc.

⚠️ **Tip:** Hover over a validity check in the upper grid to see a tooltip with the reference information (e.g. SCEA CEBoK or GAO Cost Assessment). For more information on each of these sources, refer to the **EVM Rules of Thumb**.

The **Display Options** section allows you to specify which types of validity checks you would like to see. You can display "Performance checks" (e.g. X is % greater than Y), "Sanity checks" (e.g. X exists without Y), and/or "0 count checks" (i.e. to view all checks that are completed, including those that the data "passed.")

Clicking the chart icon will display the Benford chart for the current file.

Press the **Export** button to export the results of the validity checks to Excel. You can export results for the current report period or for all report periods contained in the current file.

You can set the threshold to flag when certain errors will occur. Changing the threshold of the **Percent threshold on ACWP vs BCWP check** field may determine whether or not you see the error, "ACWP more than x% above or below planned value." For example, if the ACWP is 5.4% above the BCWP, then you will see a warning if the threshold is set to 5 or less, but you will not see the warning if the threshold is 6 or more.

Similarly, you can set the **Percent threshold on comparison checks** (e.g. "BCWP more than x% greater than BAC").

⚠️ **Tip:** You must click the **Recheck** button after changing threshold values in order to see the updated list of validity checks.

Click the **Default** button to reset the thresholds to their original values.

The CPR File Viewer performs the following validity checks:

- BCWP and BCWS data with no corresponding ACWP.
Navigating the CPR File Viewer

- BCWP with no BCWS
- BCWP with no ACWP
- ACWP with no BCWP
- BAC with no EAC
- EAC with no BAC
- Negative EAC
- Negative BAC
- BCWP more than x% greater than BAC
- BCWS more than x% greater than BAC
- ACWP more than x% above or below planned value
- ACWP more than x% greater than EAC

Refer to the EVM Gold Card for a definition of the above acronyms. The EVM Rules of Thumb explains the reasoning behind these validity checks.

Click the Export button to export the validity checks to an Excel or text file.

Browse File

The Browse File tab displays the CPR data by format. From the bottom of the page, choose a file, and if you merged multiple files, choose a period as well.

The Browse File tab is organized into five sub-tabs:

(F1) Header
(F1) WBS Elements
(F1) Summary Elements
(F3) Baseline
(F4) Staffing

Each of these sub-tabs contains information from different file formats. The formats are defined as follows:

- Format 1 - Work Breakdown Structure
- Format 2 - Organizational Categories; Not currently read by the CPR File Viewer
- Format 3 - Baseline
- Format 4 - Staffing
- Format 5 - Explanations and Problem Analyses; not currently read by the CPR File Viewer

Tip: An Excel version of the five CPR Formats can be downloaded from the Defense Acquisition University (DAU) at https://acc.dau.mil/CommunityBrowser.aspx?id=19543.

Each sub-tab of the Browse File tab is described below. Note that the letter and number in the parentheses of the tab title refers to the CPR format.
(F1) Header
The Header tab shows the metadata information associated with the file.

Select a file from the dropdown and choose a reporting period to view the data.

(F1) WBS Elements
The WBS Elements tab shows the Earned Value data associated with each WBS Element. Refer to the EVM Gold Card for a definition of the EVM acronyms.

Select a file from the dropdown and choose a reporting period to view the data.

Click on a column name to list the data according to that column.

Use the Filter by Reporting Level checkboxes to view WBS Elements associated with certain reporting levels.

Click the Freeze element name column checkbox to freeze the Element Name when scrolling to the right.

You can set certain thresholds to view data that is higher or lower than a specified value. Type the threshold values in the Highlight fields at the bottom of the page. Click the Find button to set these values and highlight the data. These fields only apply to the Cum CPI and Cum SPI columns. You can highlight data yellow and bold or red and underlined if the data varies from the number one (1) more than a specified value.
Navigating the CPR File Viewer

(F1) Summary Elements
The Summary Elements tab shows elements such as the Overhead, Management Reserve, and Total data.

<table>
<thead>
<tr>
<th>ReportDate</th>
<th>Element Name</th>
<th>Element ID</th>
<th>Reporting Level</th>
<th>Cum CPI</th>
<th>Cum SPI</th>
<th>Cum BOV</th>
<th>Cum BOvP</th>
</tr>
</thead>
<tbody>
<tr>
<td>2020-07-31</td>
<td>Overhead</td>
<td>11.1</td>
<td>2</td>
<td>0.949</td>
<td>1.106</td>
<td>86,903,890</td>
<td>86,503,890</td>
</tr>
<tr>
<td>2020-08-31</td>
<td>Overtime</td>
<td>11.0</td>
<td>2</td>
<td>1.111</td>
<td>1.213</td>
<td>57,123,700</td>
<td>68,499,820</td>
</tr>
<tr>
<td>2020-09-30</td>
<td>Productivity</td>
<td>11.2</td>
<td>2</td>
<td>1.129</td>
<td>1.219</td>
<td>243,611,000</td>
<td>84,196,820</td>
</tr>
</tbody>
</table>

Tip: Total = SubTotal + Management Reserve

Select a file from the dropdown and choose a reporting period to view the data.

Click Freeze element name column to freeze the Element Name when scrolling to the right.

(F3) Baseline
The Baseline tab shows Performance data and any Baseline changes.
Select a file from the dropdown and choose a reporting period to view the data.

Click **Freeze name column** to freeze the name when scrolling to the right.

**(F4) Staffing**
The Staffing tab shows information relating to the Staffing Estimated Costs and the Staffing Budgeted Costs.

Select a file from the dropdown and choose a reporting period to view the data.

Click **Lock vertical scroll** or **Lock Horizontal scroll** to scroll in both the "Staffing Estimated Costs" and the "Staffing Budgeted Costs" grids simultaneously.

Click **Freeze name column** to freeze the name when scrolling to the right.

**Views**

**Gold Card**
The "Gold Card" tab displays the **EVM Gold Card Overview** chart. The chart can be viewed for a selected WBS Element or at the Summary level.

Specify the date range to chart by selecting the First and Last Effective Dates from the drop downs.

For a specific WBS element, the chart plots the following items:

- Budget at Completion (BAC)
- Estimate at Completion (EAC)
- Cumulative Budgeted Cost of Work Performed (BCWP)
- Cumulative Actual Cost of Work Performed (ACWP)
Cumulative Budgeted Cost of Work Scheduled (BCWS)

At the Summary level, the chart plots the following items:

- Budget at Completion (BAC) Total
- Budget at Completion (BAC) Subtotal
- Estimate at Completion (EAC) Subtotal
- Cumulative Budgeted Cost of Work Performed (BCWP)
- Cumulative Actual Cost of Work Performed (ACWP)
- Cumulative Budgeted Cost of Work Scheduled (BCWS)

Refer to the EVM Gold Card for a definition of the above terms.

The sample chart (shown below) displays the EVM Gold Card Overview metrics for a WBS element.

Chart Details:
- Use the First and Last Effective date drop-downs to specify the date range to chart.
- Use the Scale options to set the units for dollar amounts.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the
"Set" button. To set the chart back to the default min/max values, click the "Default" button.

- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**NOTES:**

- The file must contain more than one report date in order for the chart to be created.
- Right-click on the chart to: Set Y-axis scale, Copy the chart, Export the chart data to Excel and Reorder the Chart Series.

**WBS Element**

The "WBS Element" tab displays two charts, both pertaining to a specified WBS element.

Select a file from the drop-down at the bottom. Also select a WBS element for which you would like to see data graphed.

The first chart (shown below) displays the **Summary Metrics** for the selected WBS element. The x-axis represents time, and the y-axis represents cost. The units of the y-axis are shown at the bottom of the page in the "Chart Details" group box.

The Summary Metrics chart plots the following items:

- Cumulative Budgeted Cost of Work Scheduled (BCWS)
- Cumulative Budgeted Cost of Work Performed (BCWP)
- Cumulative Actual Cost of Work Performed (ACWP)
- Cumulative Schedule Variance
- Cumulative Cost Variance
- Budget at Completion (BAC)
- Estimate at Completion (EAC)
- Variance at Completion (VAC)

Refer to the **EVM Gold Card** for a definition of the above terms.

Right-click on the chart to Set the Y-axis bounds, Copy the chart, or Export the chart data to Excel.
Navigating the CPR File Viewer

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the legend. When the box is checked, single click to have the series line appear bold on the chart. Single click *again* to uncheck the box.

The second chart on the "WBS Elements" page shows the **Performance Metrics** for the selected WBS Element. The x-axis represents time, and the y-axis is unitless (since the data plotted are indices).

The Performance Metrics chart plots the following items:

- Cumulative Cost Performance Index (CPI)
- Cumulative Schedule Performance Index (SPI)

Refer to the [EVM Gold Card](#) for a definition of the above terms.

Right-click on the chart to Set the Y-axis bounds, Copy the chart, or Export the chart data to Excel.

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the **legend**. When the box is checked, single click to have the series line appear bold on the chart. Single click *again* to uncheck the box.

**Chart Details:**
- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Scale** options to set the units for dollar amounts.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**Sub Total**

The Sub Total tab displays charts that are similar to the graphs on the "WBS Element" tab, but this tab plots the subtotal figures instead of individual WBS Elements. The data
corresponds to the "SubTotal" row on the Summary Elements section of the Browse File tab.

**Tip:** The SubTotal row is charted instead of the Total row in order to remove the variability introduced by a potentially volatile Management Reserve. Remember that Total = SubTotal + Management Reserve.

Begin by selecting a file from the drop-down at the bottom of the page.

The first chart (shown below) displays the Summary Metrics for the Subtotal cost. The x-axis represents time, and the y-axis represents cost. The units of the y-axis are shown at the bottom of the page in the "Chart Details" group box.

![Summary Metrics Chart](image)

The Summary Metrics chart plots the following items:

- Cumulative Budgeted Cost of Work Scheduled (BCWS)
- Cumulative Budgeted Cost of Work Performed (BCWP)
- Cumulative Actual Cost of Work Performed (ACWP)
- Budget at Completion (BAC)
- Estimate at Completion (EAC)

Refer to the EVM Gold Card for a definition of the above terms.

Right-click to Copy the chart or Export the chart data to Excel.

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the legend. When the box is checked, single click to have the series line appear bold on the chart. Single click again to uncheck the box.

The second chart on the "Sub Total" page shows the Performance Metrics for the Subtotal cost. The x-axis represents time, and the y-axis is unitless (since the data plotted are indices).

![Performance Metrics Chart](image)
Navigating the CPR File Viewer

The Performance Metrics chart plots the following items:

- Cumulative Cost Performance Index (CPI)
- Cumulative Schedule Performance Index (SPI)
- Cumulative Management Reserve (MR)/Original Management Reserve (MR)

Refer to the EVM Gold Card for a definition of the above terms.

Right-click to Copy the chart or Export the chart data to Excel.

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the legend. When the box is checked, single click to have the series line appear bold on the chart. Single click again to uncheck the box.

**Chart Details:**
- Use the First and Last Effective date drop-downs to specify the date range to chart.
- Use the Scale options to set the units for dollar amounts.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The Export button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**WBS Contribution**

The WBS Contribution tab shows the WBS elements’ contributions to the Estimate at Completion cost. The x-axis in the chart below represents time, and the y-axis represents an element's percent contribution to the EAC (unless the "Reported" radio button is selected, in which case the y-axis represents cost).

Select to plot the data as a Line chart or an Area chart.
Select a WBS element from the left side of the screen to **highlight** that element's corresponding line on the chart. Select a date range to narrow in on select reporting periods on the chart.

Click the **Drill Down** button (or double click on an element) to view the element's children. Click **Back** to go back to the previous parent element. Click **Top** to go to the topmost parent element. Note that these buttons only apply to reports that have more than one reporting level.

There are three options to plot EAC:
- **Reported**
- **Percent of Parent EAC**
- **Percent of Total EAC**

If **Reported** is selected, then the y-axis will show the EAC as reported on the **Browse File** tab under the WBS Elements tab for the appropriate period. Change the scale from "millions" to "dollars" to see a more precise y-value when hovering over a data point.

If **Parent EAC** is selected, then the child element's EAC is calculated as a percent of its parent EAC.

If **Total EAC** is selected, then the child element's EAC is calculated as a percent of the Total EAC.

To understand how the percent contribution is calculated, let us look at an example.
For the 2007-07-22 reporting period, the Weapon System WBS Element has a total contribution of 93.3% according to the chart. Let us check this.

On the Browse File tab, we select the period to be 2007-07-22 from the dropdown. On the WBS Elements sub-tab, look at the EAC for the Weapon System element. In this example, the EAC is $78,821,227.

Now look at the Summary Elements sub-tab. The Total EAC is $84,500,935.

To calculate the percent contribution, divide the EAC of the WBS Element by the total EAC. For this example, we have ($78,821,227/$84,500,935) *100% = 93.3%, which matches the value on the WBS Contribution Chart.
Note that if we had drilled down to a child element and had selected the "Parent EAC" radio button, then we would divide by the EAC of the parent instead of the total EAC.

Any errors associated with the creation of the chart can be seen by clicking on the "View Errors" button.

Possible errors are listed below:
- When calculating the elements contribution to Total EAC:
  - EAC is null for element X at date (date): using 0
  - Total EAC is Null or 0 for element X at date (date): using 1
- When calculating the elements contribution to Parent EAC:
  - EAC is null for element X at date (date): using 0
  - Parent EAC is 0 for element with id X at date (date): using 1

These errors warn if the EAC is blank for a certain element. If you look at the WBS Elements sub-tab on the Browse File tab, you will see that the EAC is indeed blank for the element corresponding to the WBS Code listed in the warning.

**Chart Details:**
- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**EAC & Efficiency**
Navigating the CPR File Viewer

The "EAC & Efficiency" tab shows two charts relating to the Estimate at Completion and the efficiency indices.

Begin by selecting a file from the drop-down at the bottom of the page.

The first chart (shown below) displays the **Estimate at Completion** costs. The x-axis represents time, and the y-axis represents cost. The units of the y-axis are shown in parentheses next to the "Estimate at Completion" section title.

![Estimate at Completion Chart](image)

The Estimate at Completion chart plots the following items:

- Contractor Estimated Growth (also known as the EAC)
- Contract Budget Growth (also known as the BAC)

Refer to the [EVM Gold Card](#) for definitions of the EAC and the BAC.

The Contractor Estimated Growth and the Contract Budget Growth data is derived from the [Browse File](#) data.

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the **legend**. When the box is checked, single click to have the series line appear bold on the chart. Single click **again** to uncheck the box.

The **Set Scales** option to the left of the page allows you to change how you view the y-axis. The y-axis minimum can be set using the "EAC Min" field, and the maximum can be set with the "EAC Max" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Reset" button.

Right-click to copy the chart.

The second chart (shown below) displays the **Efficiency Metrics**. The x-axis represents time, and the y-axis is unitless (since the data plotted are indices or efficiencies).
The Efficiency Metrics chart plots the following items:

- Cumulative Cost Performance Index (CPI)
- Cumulative Schedule Performance Index (SPI)
- Cumulative Management Reserve (MR)/Original Management Reserve (MR)
- Schedule Efficiency
- Modified Schedule Efficiency

Refer to the EVM Gold Card for a definition of CPI and SPI. The latter two terms are defined as follows:

**Schedule Efficiency** = \( \frac{\text{Cum ACWP/EAC}}{\text{Cum BCWS/BAC}} \)

**Modified Schedule Efficiency** = \( \frac{\text{Cum ACWP/EAC}}{\text{Cum BCWS/Original BAC}} \)

The difference between the two terms above is that the BAC in the Modified Efficiency is from the first reporting period.

The data for the Efficiency Metrics chart is derived from the Browse File tab.

Right-click to Copy the chart or Export the chart data to Excel.

To display only a few of the metrics above, use the interactive legend. Click once to highlight the series, again to remove the series, and again to display it.

**Chart Details:**
- Use the First and Last Effective date drop-downs to specify the date range to chart.
- Use the Scale options to set the units for dollar amounts.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**TCPI View Modifications**

The TCPI View Modifications chart compares the To Complete Performance Index (TCPI) and the Cost Performance Index (CPI) for the subtotal and for the selected element (chosen by the "Element to Plot" drop-down at the bottom of the dialog).

![Cost Performance Metrics, Over Time](image)

The black lines (solid and dotted) correspond to the SubTotal, whose data originates from the **Browse File** tab on the "Summary Elements" sub-tab. The red lines (solid and dotted) correspond to the selected element. Data for that element is derived from the **Browse File** tab under the "WBS Elements" sub-tab.

More specifically, the **CPI** data is reported directly on the **Browse File** tab. However, the **TCPI** refers to the **TCPI_{BAC}** and is calculated using the following formula:

$$
\text{TCPI}_{\text{BAC}} = \frac{\text{BAC} - \text{BCWP}_{\text{cum}}}{\text{BAC} - \text{ACWP}_{\text{cum}}}
$$

The Implied Budget Growth, represented by the green and blue lines, is also calculated based on data from the **Browse File** tab and can be calculated as follows:

**Implied Budget Growth** = **(BAC/CPI)** / **BAC**

The left y-axis corresponds to the CPI and TCPI metrics. The right y-axis corresponds to the Implied Budget Growth data.

**NOTE:** You can move the labels on the chart to the desired position by dragging them with the mouse.
Chart Details:

- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

Budgeted Work

The Budgeted Work chart shows the planned (BCWS) versus performance (BCWP) metrics. Note that the *current* metrics are plotted, not the cumulative.

To calculate the **Current BCWP** at a certain reporting period, first examine the Total row on the Summary Elements sub-tab of the **Browse File** tab. View the Cumulative BCWP for the current period and subtract the Cumulative BCWP from the previous period. The difference is plotted as the Current BCWP on the Budgeted Work chart.

The **Current BCWS** corresponds to the EOP in the +6 column of the Baseline sub-tab of the **Browse File** tab. Note that since the BCWS represents projected costs, the data points on the Budgeted Work chart are plotted with a six month shift relative to the period selected on the Baseline tab. For example, the +6 EOP data for a reporting period of 3/35/2007 will appear as a data point for the 9/23/2007 period on the chart.

To display only selected metrics from the list above, check or uncheck the boxes next to the desired metrics in the **legend**. When the box is checked, single click to have the series line appear bold on the chart. Single click again to uncheck the box.

Click the "View Error" button for charts that had creation errors. For example, the Budgeted Work chart cannot be generated for single report files. The error log contains these types of messages.

Chart Details:

- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Scale** options to set the units for dollar amounts.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the
"Set" button. To set the chart back to the default min/max values, click the "Default" button.

- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**Staffing Deviation**

The Staffing Deviation chart compares the six month projection to actual values for staffing in the scale reported.

Note: The series with "cum" in their title use the right y-axis, and all the other series use the left y-axis.

Seven series are plotted on this chart:

- Actuals Planned (cum)
- Actuals (cum)
- 6 Month Projection (cum)
- Baseline (cum)
- Actuals
- 6 Month Projection
- Baseline

The **Actuals Planned (cum)** data is derived from the Staffing Estimate (top) grid on the Staffing sub-tab of the Browse File tab. The data point that falls on the line between Actuals and Planned on the chart corresponds to the sum of the top level (often Level 2) Staffing Estimate Cumulative Values for the last reporting period. The second point is the sum of the previous data point and the "+1" values of the top level Staffing Estimate. The third point takes the value of the second point and adds the "+2" values, and so on.

The **Actuals (cum)** data is derived from the Staffing Estimate (top) grid on the Staffing sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Estimate Cumulative Values for the appropriate reporting period.

The **6 Month Projection (cum)** data is derived from the Staffing Budget (bottom) grid on the Staffing sub-tab of the Browse File tab. Each data point corresponds to the sum of the cumulative values of the top level elements on the Staffing Budget grid and the sum of the "+1, +2, +3, +4, +5, and +6" values, all for a period six months prior.

The **Baseline (cum)** data is derived from the Staffing Budget (bottom) grid on the Staffing sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Budget Cumulative Values for the appropriate reporting period.
The **Actuals** data is derived from the Staffing Estimate (top) grid on the **Staffing** sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Estimate **Current** Values for the appropriate reporting period.

The **6 Month Projection** data is derived from the Staffing Estimate (top) grid on the **Staffing** sub-tab of the Browse File tab. The first data point corresponds to the sum of the "+6" values of the top level elements on the Staffing Estimate grid for a period six months prior. The next data point corresponds to the "+6" values for the next period, and so on.

The **Baseline** data is derived from the Staffing Budget (bottom) grid on the **Staffing** sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Budget **Current** Values for the appropriate reporting period.

NOTE: You can move the labels on the chart to the desired position by dragging them with the mouse. You can double-click on the text box at the top of the chart to edit it, and create your own custom text.

**Chart Details:**

- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**Dashboard: Staffing**

The Dashboard: Staffing chart compares the six month projection to actual and baseline values for staffing in the scale reported.

Three series are plotted on this chart:

- Baseline
- Forecast
- Actual
Navigating the CPR File Viewer

The **Baseline** data is derived from the Staffing Budget (bottom) grid on the **Staffing** sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Budget Current Values for the appropriate reporting period.

The **Forecast** data is derived from the Staffing Estimate (top) grid on the **Staffing** sub-tab of the Browse File tab. The first data point corresponds to the sum of the "+6" values of the top level elements on the Staffing Estimate grid for a period six months prior. The next data point corresponds to the "+6" values for the next period, and so on.

The **Actual** data is derived from the Staffing Estimate (top) grid on the **Staffing** sub-tab of the Browse File tab. Each data point corresponds to the sum of the top level Staffing Estimate Current Values for the appropriate reporting period.

To display only selected metrics from the **Series Selection** list above, check or uncheck the boxes next to the desired metrics. When the box is checked, single click to have the series line appear bold on the chart. Single click *again* to uncheck the box.

**Chart Details:**
- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**Staffing Changes**

The Staffing Changes chart compares the last six reports’ current values and projections (+1, +2, ... +6) against each other for staffing data. Data for the last six reporting periods are plotted.

The data is derived from the **Staffing** sub-tab of the Browse File tab. For each series, select the appropriate period on the staffing tab. The first data point corresponds to the sum of the Current Values on the Staffing Estimate (top) grid for the top level (typically Level 2) elements. The second data point corresponds to the sum of the "+1" values for the top level elements. The third data point corresponds to the sum of the "+2" values, etc.
To display only selected report dates from the Series Selection list, check or uncheck the boxes next to the desired date. When the box is checked, single click to have the series line appear bold on the chart. Single click again to uncheck the box.

Select a different reporting period on the Browse file tab to view data for a different series on the Staffing Changes chart.

**Chart Details:**
- The First and Last Effective dates show the first and last report dates being plotted.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The Reorder Series option allows you to specify the order in which the various series are plotted.
- The Export button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**Baseline Changes**

The Baseline Changes chart compares the last six reports' current costs and projections (+1, +2, ... +6) against each other for cost data. Data for the last six reporting periods are plotted.

The data is derived from the Baseline sub-tab of the Browse File tab. For each series, select the appropriate period on the Baseline tab. The first data point corresponds to the Current BCWS BOP (Beginning of Period.) The second data point corresponds to the "+1" on the EOP (End of Period) row. The third data point corresponds to the "+2" EOP, and so on.

To display only selected report dates from the Series Selection list, check or uncheck the boxes next to the desired date. When the box is checked, single click to have the series line appear bold on the chart. Single click again to uncheck the box.

Select a different reporting period on the Browse File tab to view data for a different series on the Baseline Changes chart.

**Chart Details:**
- The First and Last Effective dates show the first and last report dates being plotted.
- Use the Scale options to set the units for dollar amounts.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can
be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.

- The Reorder Series option allows you to specify the order in which the various series are plotted.
- The Export button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

Management Reserve (MR) Accounting

The "Mgmt Reserve" tab displays the Management Reserve (MR) in dollars (shaded area) for each reporting period, the MR remaining divided by the Work remaining (solid line) and the Baseline MR remaining divided by Work Remaining (dashed line).

Three series are plotted on this chart:

- Management Reserve in dollars (uses the left y-axis)
- MR Remaining/Work Remaining (uses the right y-axis)
- Baseline MR Remaining/Work Remaining (uses the right y-axis)

NOTE: Work Remaining = BAC-Cum BCWP

The Management Reserve data comes from the Management Reserve line of the Summary Elements sub-tab of the Browse File tab. Data is plotted for report dates between the selected First and Last Effective Dates.

The MR Remaining/Work Remaining (BAC - Cum BCWP) data is derived from the Management Reserve and SubTotal(PMB) lines of the Summary Elements sub-tab of the Browse File tab. Data is plotted for report dates between the selected First and Last Effective Dates.

The Baseline MR Remaining/Work Remaining (BAC - Cum BCWP) data is derived from the Management Reserve and SubTotal(PMB) lines of the Summary Elements sub-tab of the Browse File tab. Data is plotted for the baseline, or second report date and is fixed at that value.

Chart Details:

- Use the First and Last Effective date drop-downs to specify the date range to chart.
- Use the Scale options to set the units for dollar amounts.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
The Reorder Series option allows you to specify the order in which the various series are plotted.

- The Export button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

NOTES:
- You can move the labels on the chart to the desired position by dragging them with the mouse.
- The file must contain more than one report date in order for the chart to be created.
- Right-click on the chart to: Set Y-axis scale, Copy the chart, Export the chart data to Excel and Reorder the Chart Series.

**Burn Rate**

The "Burn Rate" tab displays the monthly burn rate for the selected WBS element.

Fives series are plotted on this chart:

- Current ACWP for the project
- Current ACWP for the selected WBS element
- Linear approximation of the Current ACWP for the project
- Linear approximation of the Current ACWP for the selected WBS element
- Polynomial approximation of the Current ACWP for the project

The Show Linear and Show Polynomial check-boxes allow you to show or hide those series.

**Chart Details:**

- Use the First and Last Effective date drop-downs to specify the date range to chart.
- Use the Set Y-axis scale option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The Reorder Series option allows you to specify the order in which the various series are plotted.
- The Export button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

**EAC Growth Rate**

The "EAC Growth Rate" tab plots the EAC for each report period for all level 1 WBS elements (reporting level 2).
Navigating the CPR File Viewer

Chart Details:
- Use the **First and Last Effective date** drop-downs to specify the date range to chart.
- Use the **Set Y-axis scale** option to change the scale of the y-axis. The y-axis minimum can be set using the "Minimum" field, and the maximum can be set with the "Maximum" field. Type in the new min or max and click the "Set" button. To set the chart back to the default min/max values, click the "Default" button.
- The **Reorder Series** option allows you to specify the order in which the various series are plotted.
- The **Export** button drop-down allows you to either Export the Chart Data to Excel or Copy the chart to the clipboard.

Export to Excel

The CPR File Viewer provides the option to export CPRs to Excel in various formats. The buttons and options on this tab are described below:

**Choose a File** - Begin by selecting a file from the drop-down at the bottom of the page.

**Select by Reporting Level** - You can check which WBS elements are exported by specifying the reporting level of the desired items to export. For example, if you click the checkbox next to "2," then only WBS Elements of Reporting Level 2 will be exported to Excel. If there are multiple reporting levels in the file, then you can click the **Check All** or **Uncheck All** buttons to easily check/uncheck the reporting levels.

⚠️ **Tip:** The list of elements at the top of the page will vary depending on which reporting level(s) is selected. For example, if Reporting Level 2 is the only level checked, then only elements of Reporting Level 2 will be displayed on the page.

**Export Options** - The following options are available:

- **Output multiple periods as worksheets:** If this option is selected, the CPR data is exported into the following sheets in Excel: CPR Header, WBS Elements, Summary Elements, Baseline Elements, Staffing Budgeted, and Staffing Estimated. If the file was merged, then data from all the periods are shown.

- **Export single period:** If this option is selected, the CPR with the chosen reporting period is exported to the standard CPR format. The Excel file contains the following sheets of data: WBS Format 1, OBS Format 2, Baseline Format 3, Staffing Format 4 (BAC), and Staffing Format 4 (EAC.)

- **Export flat WBS data:** If this option is selected, then the data is exported to a single sheet in Excel. The WBS elements and their EVM metrics (e.g. Cum CPI, BAC, etc.) are listed.
- **Export by EVM Metric**: If this option is selected, then the data is exported to four worksheets in Excel, one sheet for each metric: EAC, Cum ACWP, Cum BCWP, and Cum BCWS. The WBS elements are listed as rows and each report date is a column.

Export Excel Format - You have the option to export the file to Excel 2003 (with an .xls extension) or to Excel 2007 (with an .xlsx extension).

**Export** - Click the Export button after you have selected at least one reporting level to include in the export and have set the export options.

**Options**

The Options menu is located on the main CPR File Viewer toolbar. The following options are available:

**Resize form to default**: The CPR File Viewer window can be resized by dragging the lower right-hand corner. To automatically set the window back to its default size, click Options>Resize form to default. The default size depends on your personal setting (see the next paragraph).

**Set the default**: To set the default size, click Options and choose a size (such as 1024 x 768).

**Date Format**: Three date format options are available (dd/mm/yyyy, yyyy-mm-dd, and mmm-yy.) These affect the format of dates in forms and on charts.

**Debug mode**: The debug mode is used for testing and programmatic purposes and can be disregarded.
References

Installation Instructions


The link you receive to download this application will contain a CPRDex.zip file. Save it somewhere you can locate. Once unzipped, it will contain an ‘fv_20110124’ folder. Within this folder are another folder and a shortcut. Clicking this shortcut icon will start the application. If, for any reason, the included shortcut doesn't work, open the “CPRFileViewer” folder and look for the “CPRFileViewer.exe” icon. This will also start the program up.

Once the application is installed, check to make sure that you can view the integrated help. If you click Help>About File Viewer and you receive a message that says "Navigation to the webpage was canceled" (as shown in the image below), then you must perform the steps outlined beneath this image.

1. Open the CPR File Viewer folder in Windows Explorer.
2. Right click on CPR_File_Viewer.chm and click Properties.
3. Click the "Unblock" button (shown below).

4. Click OK.
5. The next time you open the help, it should display properly.

EVM Gold Card

The EVM Gold Card can be obtained online from the Defense Acquisition University (DAU).

The 2010 version of the Gold Card is shown below.
**Earned Value Management**

**'Gold Card'**

- **Management Reserve**
- **Schedule Variance**
- **Cost Variance**
- **ACWP**
- **BCWS**
- **BCWP**
- **EAC**
- **TAB**
- **BAC**

**VARIANCES**
Favorable is Positive, Unfavorable is Negative

<table>
<thead>
<tr>
<th>Metric</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Variance CV</td>
<td>CV = BCWP - ACWP</td>
</tr>
<tr>
<td></td>
<td>CV% = (CV / BCWP) \times 100</td>
</tr>
<tr>
<td>Schedule Variance SV</td>
<td>SV = BCWP - BCWS</td>
</tr>
<tr>
<td></td>
<td>SV% = (SV / BCWS) \times 100</td>
</tr>
<tr>
<td>Variance at Completion VAC</td>
<td>VAC = BAC - EAC</td>
</tr>
</tbody>
</table>

**OVERALL STATUS**

<table>
<thead>
<tr>
<th>Metric</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Schedule</td>
<td>(BCWS_{Cum} / BAC) \times 100</td>
</tr>
<tr>
<td>% Complete</td>
<td>(BCWP_{Cum} / BAC) \times 100</td>
</tr>
<tr>
<td>% Spent</td>
<td>(ACWP_{Cum} / BAC) \times 100</td>
</tr>
</tbody>
</table>

**DoD TRIPWIRE METRICS**

- **CPI** = BCWP / ACWP
  - Favorable is > 1.0, Unfavorable is < 1.0
- **SPI** = BCWP / BCWS
  - Favorable is > 1.0, Unfavorable is < 1.0
- **BEI** = Tasks with Actual Finish Date / (# of Baseline Tasks Scheduled to Finish Prior to Status Date + Tasks Missing Baseline Start or Finish Date)
- **CPLI** = (CP Length_{Time Now To Contract End}) + Total Float_{To Contract End Baseline Finish} / CP Length
  - Hit / Miss = Month's Tasks Completed ON or AHEAD / Month's Tasks Scheduled to Complete

**# ESTIMATE AT COMPLETION** (EAC) = Actuals to Date + [(Remaining Work)/(Performance Factor)]

<table>
<thead>
<tr>
<th>Metric</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAC_{CPI}</td>
<td>ACWP_{Cum} + [(BAC - BCWP_{Cum}) / CPI_{Cum}]</td>
</tr>
<tr>
<td>EAC_{Composite}</td>
<td>ACWP_{Cum} + [(BAC - BCWP_{Cum}) / (CPI_{Cum} \times SPI_{Cum})]</td>
</tr>
</tbody>
</table>

**# $ TO COMPLETE PERFORMANCE INDEX** (TCPi)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCPi_{EAC}</td>
<td>Work Remaining / Cost Remaining = (BAC - BCWP_{Cum}) / (EAC - ACWP_{Cum})</td>
</tr>
</tbody>
</table>

# To Determine a Contract Level TCPi or EAC; You May Replace BAC with TAB

§ To Determine the TCPi_{BAC or LRE} Replace EAC with BAC or LRE
ACRONYMS
ACWP Actual Cost of Work Performed  Cost of work accomplished = ACTUAL COST
AUW Authorized Unpriced Work  Work contractually approved, but not yet negotiated / defined
BAC Budget At Completion  Total budget for total contract thru any given level
BCWP Budgeted Cost of Work Performed  Value of work accomplished = EARNED VALUE
BCWS Budgeted Cost of Work Scheduled  Value of work planned to be accomplished = PLANNED VALUE
CA Control Account  Lowest CWBS element assigned to a single focal point to plan & control scope / schedule / budget
CBB Contract Budget Base  Sum of NCC & AUW
EAC Estimate At Completion  Estimate of total Cost for total contract thru any given level may be generated by Ktr, PM, DCMA, etc. = EAC_{conf} / PM / DCMA
LRE Latest Revised Estimate  Ktr’s EAC or EAC_{conf}
MR Management Reserve  Budget withheld by Ktr PM for unknowns / risk management
NCC Negotiated Contract Cost  Contract Price Minus profit or fee(s)
OTB Over Target Baseline  Sum of CBB & recognized overrun
PAC Price At Completion  NCC Plus Profit or Fee(s)
PMB Performance Measurement Baseline  Contract time-phased budget plan
PP Planning Package  Far-term CA activities not yet defined into WPs
SLPP Summary Level Planning Package  Far-term activities not yet defined into CAs
TAB Total Allocated Budget  Sum of all budgets for work on contract = NCC, CBB, or OTB
TCPI To Complete Performance Index  Efficiency needed from ‘time now’ to achieve a BAC, EAC, or LRE
UB Undistributed Budget  Broadly defined activities not yet distributed to CAs
WP Work Package  Near-term, detail-planned activities within a CA

EVM POLICY: DoD 5000.02, Encl 4. Table 5. EVMS in accordance with ANSI/EIA-748 is required for cost or incentive contracts, subcontracts, intra-government work agreements, & other agreements valued ≥ $20M (Then-Yr $).
EVMS contracts ≥ $50M (TY $) require that the EVM system be formally validated by the cognizant contracting officer. Additional Guidance in Defense Acquisition Guidebook & Earned Value Management Implementation Guide (EVMIG). EVMS is discouraged on Firm-Fixed Price & Time & Material Contracts; & LOE activities regardless of cost.

EVM CONTRACTING REQUIREMENTS:
FAR EVM Clauses  NOT FOR DOD  - 52.234-2 for Solicitation = Pre-Award IBR or - 52.234-3 = Post Award IBR
FOR DO D ≥ $20M DFARS CLAUSES  - 52.234-7001 "NOTICE OF EVMS" FOR SOLICITATIONS
- 52.234-7002 "EVMS" FOR SOLICITATIONS & CONTRACTS

CONTRACT PERFORMANCE REPORT  - DODMGMT-81466A* 5 FORMATS = WBS, ORGANIZATION, BASELINE, STAFFING, EXPLANATION
INTEGRATED MASTER SCHEDULE  - DODMGMT-81650A MANDATORY FOR DoD EVMS CONTRACTS
INTEGRATED BASELINE REVIEW  - MANDATORY FOR ALL EVMS CONTRACTS
* See the EVMIG for CPR & IMS tailoring guidance

EVM Home Page = https://acc.dau.mil/evm
eMail Address: EVM.dau@dau.mil
Revised September 2010
EVM Rules of Thumb

A list of common EVM Rules of Thumb is shown below. These rules are taken from the GAO Cost Assessment and the SCEA CEBoK. The corresponding page number is shown for reference.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valuable metric; should be included</td>
<td></td>
</tr>
<tr>
<td>GAO and SCEA info agree</td>
<td></td>
</tr>
<tr>
<td>GAO and SCEA somewhat agree</td>
<td></td>
</tr>
<tr>
<td>GAO and SCEA somewhat disagree</td>
<td></td>
</tr>
</tbody>
</table>

GAO Cost Assessment
<table>
<thead>
<tr>
<th>GAO Cost Assessment</th>
<th>Definitive Measure?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Amount of LOE</strong></td>
<td></td>
</tr>
<tr>
<td>As a general rule, if more than 15 percent of a program's budget is classified as level of effort, then the amount should be scrutinized. [With LOE], because performance always equals planned (scheduled) cost, no schedule variances occur. Cost variances may occur if actual costs are higher than planned.</td>
<td>p. 226</td>
</tr>
<tr>
<td><strong>Management Reserve (MR)</strong></td>
<td></td>
</tr>
<tr>
<td>Programs typically set their contract value so they can set aside 5-10 percent as management reserve. This amount may not be sufficient for some programs and may be more than others need. The best way to calibrate the amount of management reserve needed is to conduct a risk analysis. If the percent of management reserve consumed is much higher than percent complete, the program is likely not to have sufficient budget to mitigate all risks.</td>
<td>p. 224</td>
</tr>
<tr>
<td><strong>Sanity Checks (Anomalies)</strong></td>
<td></td>
</tr>
<tr>
<td>negative values for ACWP, BAC, BCWP, BCWS, or EAC</td>
<td>p. 257</td>
</tr>
<tr>
<td>unusually large performance swings (BCWP) from month to month</td>
<td>Y</td>
</tr>
<tr>
<td>BCWP and BCWS data with no corresponding ACWP</td>
<td>Y</td>
</tr>
<tr>
<td>BCWP with no BCWS</td>
<td>Y</td>
</tr>
<tr>
<td>BCWP with no ACWP</td>
<td>Y</td>
</tr>
<tr>
<td>ACWP with no BCWP</td>
<td>Y</td>
</tr>
<tr>
<td>Inconsistency between EAC and BAC, such as no BAC but an EAC and vice versa</td>
<td>Y</td>
</tr>
<tr>
<td>BCWP or BCWS exceeds BAC</td>
<td>Y</td>
</tr>
<tr>
<td>ACWP that is way above or below the planned value</td>
<td>N</td>
</tr>
<tr>
<td>ACWP exceeds EAC</td>
<td>Y</td>
</tr>
<tr>
<td><strong>% Planned % Complete % Spent</strong></td>
<td></td>
</tr>
<tr>
<td>If percent planned is much greater than percent complete, the project is significantly behind schedule. If percent spent is much greater than percent complete, the project is significantly overrunning its budget.</td>
<td>p. 260</td>
</tr>
<tr>
<td><strong>Cost Variance (CV) and Cost Performance Index (CPI)</strong></td>
<td></td>
</tr>
<tr>
<td>a CPI less than 1 is unfavorable; a CPI greater than 1 is favorable</td>
<td>p. 259</td>
</tr>
<tr>
<td>A CPI less than 1.0 is cause for concern because, without exception, the cumulative CPI tends to decline after a program is 15% complete</td>
<td>p. 260</td>
</tr>
<tr>
<td>Once a program is 20% complete, the cum CPI does not vary much from its value (less than 10%) and most often tends to get worse as completion nears</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Schedule Variance (SV) and Schedule Performance Index (SPI)</strong></td>
<td></td>
</tr>
<tr>
<td>An SPI less than 1 indicates that work is not being completed as planned and the program may be behind schedule. If the incomplete work is on the critical path; an SPI greater than 1 means work has been completed ahead of the plan.</td>
<td>p. 259</td>
</tr>
<tr>
<td>An SPI different from 1.0 warrants more investigation to determine what effort is behind or ahead of schedule</td>
<td>p. 260</td>
</tr>
<tr>
<td>For SPI: Favorable is &gt; 1.0, Unfavorable is &lt; 1.0</td>
<td>*Gold Card</td>
</tr>
<tr>
<td>If the TCPI is more than 5% higher than the CPI, it is too optimistic</td>
<td>p. 260</td>
</tr>
</tbody>
</table>
## CPR File Viewer User Guide

<table>
<thead>
<tr>
<th>Program Requirements for EVM</th>
<th>SCAE CEBoK</th>
<th>Definitive Measure?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earned value not required for contracts under $20M unless risk is sufficiently high. Contracts between $20M-$50M require a tailored version of the CPR along with an IMS. Contracts exceeding $50M require a full [k format] CPR and an IMS.</td>
<td>p. 15</td>
<td>?</td>
</tr>
</tbody>
</table>

### Amount of LOE

[Int] LOE. Performance always equals scheduled amount, so schedule variances should not occur. Cost variance can occur if actual costs are higher than expected. | p. 16 | ? |

### Management Reserve (MR)

- There may be an issue if the % of MR used is much greater than the % complete unless the % complete is close to 100%.
- Compare MR remaining with % FMB remaining (or MR balance vs BCWP) to assess if MR is expended at a rate similar to how the program is acquiring.
- Compare MR use with CV and SV to assess if MR is being used to cover problems.
- Compare PMB and CRR. PMB will merge as MR is used.
- There should be some MR left after the contract closes to account for DCMA approved rate changes. | p. 53 | N |

### Sanity Checks (Anomalies)

| BCWS, BCWP, ACWP are negative | Y |
| BAC < 0 and/or EAC < 0 | Y |

| BCWP > 0 and BCWS = 0 | Y |
| BCWP > 0, ACWP = 0 | Y |
| ACWP > 0 and BCWP = 0 | Y |
| BAC > 0 and EAC = 0 | Y |
| BAC > 0 and EAC > 0 | Y |
| BCWP or BCWS > BAC | Y |
| BCWS = BCWP = ACWP | Y |

### % Planned Complete Spent

- There may be an issue if the % planned is much greater than the % complete and/or the % spent is much greater than the % complete. | p. 55 | N |

### Cost Variance (CV) and Cost Performance Index (CPI)

| CPI - values lower than 1.0 are unfavorable, CPI values higher than 1.0 are favorable | p. 50 | Y |
| Cum CPI is usually stable once the project is 15-20% complete | p. 124 | Y |

### Schedule Variance (SV) and Schedule Performance Index (SPI)

| SPI - values over 10% are significant | p. 45, p. 63 | Y |
| Cum SPI is usually stable once the project is 15-20% complete | p. 46, p. 63 | Y |
| Early SV is typically used to SPI later | N |

### TCPI and LRE

| ATCPI/LRE more than 5% greater than cum CPI is excessively optimistic | p. 57 | Y |
# Index

**B**  
Baseline ........................................ 7  
Baseline Changes ................................ 26  
Browse File ....................................... 7  
Budgeted Work .................................. 22  
Burn Rate ........................................ 28  

**C**  
CPR Format ....................................... 7  

**D**  
Dashboard  
  Staffing ...................................... 24  
Date .................................................. 30  
DAU .................................................. 7, 32  
Default ............................................. 30  

**E**  
EAC & Efficiency ................................ 18  
EAC Growth Rate ................................ 28  
edi .................................................... 1  
EVM Validity Checks .............................. 5  
Excel .................................................. 29  
Export ............................................... 5  
Export to Excel .................................. 29  

**F**  
Filter by Reporting Level ...................... 7  
Find .................................................. 7  
Freeze .............................................. 7  

**G**  
Getting Started .................................. 2  
Gold Card ........................................ 10, 32  
Gold Card View .................................. 10  

**H**  
Header ............................................. 7  
Help .................................................. 31  
Highlight ......................................... 7  

**I**  
Installation ...................................... 31  

**L**  
Lock Horizontal Scroll ......................... 7  
Lock Vertical Scroll ............................. 7  

**M**  
Management Reserve ............................ 27  
Merge ................................................ 5  
Microsoft .Net Framework ...................... 31  

**O**  
Open Files ........................................ 5  
Options ............................................. 30  
Overview ......................................... 1  

**R**  
Rules of Thumb .................................. 36  

**S**  
Size .................................................. 30  
Staffing ............................................ 7  
Staffing Changes ................................ 25  
Staffing Deviation ............................... 23  
Sub Total .......................................... 13  
Summary Elements ............................... 7  

**T**  
TCPI View Modifications ....................... 21  
Threshold .......................................... 5  
trn ..................................................... 1  

**V**  
VAC .................................................. 32  

**W**  
WBS Contribution ............................... 15  
WBS Elements .................................. 7, 12  
What's New ....................................... 3  
wsa ................................................... 1  

**X**  
xml ................................................... 1  

---

39